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Image Registration

The goal of image registration is to determine a spatial transformation that will bring into alignment separately acquired images of the same 

object. When accurately registered, each separate image will have the same coordinate system and same voxel size, a voxel in one image 

will represent the same physical location as the corresponding voxel in the other image. The registration process interpolates the registered 

images as they are resampled and/or reformatted during the registration process. For example, registration of an axial PET data set to a 

sagittal MRI data set results in the PET data being transformed (resampled and reformatted) into the sagittal MRI space.

Registration is a prerequisite for several applications including; the display, segmentation, and analysis of structural and functional data, 

algebraic manipulation of image data (image addition, subtraction, multiplication, and division), the analysis of dynamic image data, and the 

fusion of data from multiple images.

Introduction
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Image Fusion

Image fusion is the process of combining, into one image, the information from multiple registered images. For example, the registration of 

an axial PET to a sagittal MRI allows for the transformed PET image data to be superimposed upon the sagittal MRI and output as a single 

fused volume illustrating both structure and function.

Transformation

Transformation is the process of changing a match data set to align with the base data set using the parameters calculated during 

registration, these parameters include; translation, rotation, scaling, and shear. 

Translation: A translation moves data to a different position. A 2D image can be moved left, right, up or down. A 3D volume can be moved 

left, right, up, down, backwards or forwards. 

Rotation: Rotation rotates the data at a particular angle from its origin. 

Scaling: Scaling changes the size of a data set. Scaling either expands or compresses the dimensions of the image data. 

Shear: Shearing, sometimes referred to as skewing, is a transformation that slants the shape of the data.

Introduction (continued)
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The register module is divided 

into several areas: 1) the menu, 2) 

tools, 3) the display area, and 4) the 

registration controls.

Menu

File: The File menu allows users to 

load the base and match data, load 

and save transformed object maps, 

and save transformed match data. 

The File options include:

•	 Input/Output: Displays a 

Volume area at the bottom of 

the Register module window. 

This area facilitates the dragging 

and dropping of image data into 

the module and the reversing of 

inputs via the Swap Inputs button.

Register Module Interface
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File >Input/Output (continued): 
Tip: Swapping inputs is useful when you register a match 

data set to a base data but need the base data set 

transformed into the space of the match data set. This 

situation can arise when you are unable to register image 

A to image B, but are able to register image B to image A.

•	 Load Object Map: Allows users to load an object map 

for the Base and/or Match volume. When selected a 

window will be returned prompting the user to specify 

which volume the object map should be loaded for. 

There is also the option to cancel the object map load. 

Once Base or Match is selected a Load Object Map 

window will open allowing users to navigate to, select, 

and load an object map file. The following options are 

available:

·· Current Directory: Takes user to the current 

directory, the current directory is set by right-

clicking in the main Analyze 14.0 window and then 

choosing Current Directory from the menu. 

·· Workspace Directory: Takes user to the current 

Workspace directory.

·· Home Directory: Takes user to the user’s Home 

directory. 

·· Cancel Load: Cancels load of the object map.

Menu (Continued)
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File (continued):

•	 Unload Object Map: Allows users to unload the Base, Match, or both 

object maps. Users also have the option to cancel the object map 

unloading process.

•	 Save Registered: The Save Registered option allows users to save the 

transformed match data set, the fused image data, or the transformed 

match object map – only available if a match object map was loaded.

When the Save Object Map option is selected users will be prompted 

to save the object map or cancel the save. When Save Object Map is 

selected a new window will open providing users with the option to 

overwrite the loaded object map (Yes) or to save as a new object map 

(No, I want to specify a name and location).

•	 Exit: Closes the module

Other: The other menu provides access to the Options and Powerbar 

editor menus.

Menu (Continued)

Other > Options: When selected opens the Options menu providing access to Module configuration options, including:

•	 Intensities Linked:  Allows users to enable or disable linked intensity adjustment. When linked any adjustment an images intensity 

display will be applied to all grayscale slices displayed. When disabled image intensities can be adjusted individually.

•	 Linked Pan: Allows users to enable (default) or disable linked image panning. Note that linked panning only applies to the current row of 

images. Disabling linked pan allows you to pan a single image at a time.
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Other > Options (continued):

•	 Linked Zoom: Allows users to enable or disable linked zooming. The following options are available:

·· Both: Both is the default option, when selected any zoom in/out on an image is applied to all images for both input data sets.

·· Row: Allows zooming to be applied to the current row of images.

·· Column: Allows zooming to be applied to the current column of images.

Menu (Continued)

•	 Linked Blend: The linked blend option allows for the enabling (default) and disabling of the same blend type to be applied to all fused 

images in the center column. Keep enabled if you wish to apply the same blend option to all fused images, disable if you wish to apply 

different blend options to the fused images. 

•	 Adjust Scale: Allows users to enable or disable (default) the scale tool for the match data allowing for interactive image scaling.

•	 Auto Note Update: Allows the Auto Note Update option to be enabled or disabled.

•	 Threads: Allows users to specify the number of threads used in a multi-threaded rendering process. By default, the number of threads is 

set to the number of processors on the system.

Other > Powerbar Editor: Provides access to the Powerbar Editor allowing users to add and remove tools from the tools area. See the 

Powerbar Editor description in the Segment section for further information. 

Help: The Help menu provides users with quick access to help resources including:

•	 About: View version, system and environment information.

•	 Users Guide: Opens the Analyze 14.0 User’s Guide.

•	 Get Help: Opens the AnalyzeDirect Support Page.
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The Tools options provide access to the Toggle Cursor Link, Toggle Region Display and the Set Note State tools. For further information on 

these tools please refer to section 2. Image Display, Controls and Customization.

•	 Reset Matrix: The reset matrix tool is unique to Register and allows users to reset the match data sets matrix at any time. To reset the 

match registration matrix simply click the Reset Matrix button. 

Tools

Display Area

The Register display area consists 

of; 1) the base image display, 2) the 

match image display, 3) the fused 

image display, 4) the linked cursor 

tool, 5) linked cursor coordinates, 6) 

slice display tool, 7) image display 

controls, 8) blend type options, and 9) 

manual registration tools.
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Display Area: The Register module display area is a nine-panel display divided into three columns and three rows; each column displays a 

different data set while each row displays a different orientation.  The first column [1] displays the base data set, the third column [2] displays 

the match dataset, while the middle column [3] displays a fused image - a blended combination of the base and match data. The top row 

displays all three image data sets (base, fused, and match) in the axial orientation, the middle row displays all three data sets in the coronal 

orientation, and the bottom row displays all three data sets in the sagittal orientation. 

The Cursor Link: The cursor link [4] allows users to interactively navigate through the input image data. The cursor linked tool can by 

adjusted in any of the nine display panels interactively updating all nine simultaneously. The linked cursor coordinates as well as the voxel 

intensity value for both the base and match volumes are displayed in the lower left-hand corner. [5] The cursor link can be enabled or 

disabled using the Toggle Cursor Link button.

The Slice Tool: Users can navigate through image slices using the slice tool. Click the yellow Slice text in the lower left-hand corner of the 

base axial, [6] coronal, or sagittal image display. An up/down slice cursor will appear. Hold down the left mouse button and slide the cursor 

upward to move to a higher slice number and downward to move to a lower slice. 

Display Area (Continued)

Users can quickly navigate to the First, Middle and Last slice by right-clicking the 

yellow Slice text. A specific slice number can be chosen by double-clicking the 

yellow Slice text and typing in the desired slice number.

Image Display Controls: Register provides users with access to the Zoom, Pan, and 

Max/Min tools [7].

•	 Zoom Tool: Users can increase and decrease the display size of the data using 

the Zoom tool. Click on the yellow Zoom text in the bottom right corner of the
image pane. A zoom cursor will be displayed. While clicking and holding the left mouse button, move the mouse upward to zoom in and 

downward to zoom out. Let go of the left mouse button when the desired zoom factor is reached. For a full description of the Zoom tool 

including right mouse menu options please refer to the Zoom tool in Section 2. Image Display, Controls and Customization.
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Image Display Controls > Zoom Tools (Continued):  Note: Linked Zooming can be disabled, enabled, or enabled for just columns or rows. 

See the Other > Options menu description above for additional information.

•	 The Pan tool: The Pan tool is automatically enabled in Register. Click on the yellow Pan text in the bottom right corner of the axial, 

sagittal, or coronal base images. A pan cursor will be displayed. While clicking and holding the move the cursor to pan the image. 

Panning is linked for the selected row, to pan the current image only disable Linked Pan in the Other > Options menu for additional 

information see the Other > Options menu description above.

Display Area (Continued)

•	 Max/Min tool: The Max and Min display intensities of the base data set can be 

changed by clicking on the yellow Max/Min Tool at the bottom right corner of 

the axial base image window. A cursor will return that allows the values to be 

manipulated. Hold down the left mouse button and move the mouse up/down or 

left/right to adjust the display. To change the intensity display of the match data, 

click on the yellow Max/Min Tool at the bottom right corner of the match image 

window. For a complete description on how to how values are changed with the 

Max/Min tool please Section 2. Image Display, Controls and Customization. 

Blend Type Options: The blend type in 

the lower left-hand corner of the fused 

axial image [8] can be used to adjust the 

blended composition of the fused image. 

To adjust the blend type, left click on the 

yellow Blend Type text to toggle through 

the blend type options, alternately, right 

click on the yellow Blend Type text and 

choose a blend type from the menu [9].
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•	 Average (Ignore 0’s): Like the Average blend option the Average (Ignore 0’s) option linearly interpolates the base and match images to 

form the fused image, however, voxels with a value of 0 in the base image are not included when creating the fused image. 

Display Area (Continued)

•	 Average: The Average blend option linearly interpolates the base and match 

images to form the fused image.

·· Blend Percent: The blend percent option is available when the Average blend 

type option is selected. The blend percent allows users to adjust the percent 

of the Base image used in the interpolation to form the fused image. The 

default blend percent is 50, lowering the percentage will lower the amount the 

base image displayed in the fused image, higher the percentage will increase 

the amount of the base image displayed in the fused image. Double-click 

on the yellow Blend Percent text to enter a percent value or right-click and 

choose a value from the menu. 

Blend Type Options (continued): 

Blend type adjustment is helpful for the visual 

assessment and verifications of registration, especially 

when the base and match images are both grayscale 

[10].

The following blend types are available:
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Display Area (Continued)

·· Blend Percent: The blend percent option for the Average (Ignore 0’s) blend options works and functions the same as the blend 

percent option for the Average blend option.

•	 Checkerboard: This function depicts the base and match volumes in a checkerboard pattern. The following options are available:

·· Grid Size: Allows users to specify the size of squares used to create the checkerboard grid. 

·· Toggle Grid: Switches the base and match volume inputs for the checkerboard squares [13].

Blend Type Options > Average (Ignore 0’s) (continued): 

In the example here, a rectangular region has been removed from the base image and the voxel values set to 0 [11]. Instead of a black 

rectangle appearing in the fused image, these voxels are ignored and the voxels from the match image are displayed [12].
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Display Area (Continued)

Blend Type Options (continued): 

•	 Difference: The difference option 

subtracts the base volume from 

the match, directly showing the 

difference between volumes [14]. 

 

•	 Red-Green: The red-green blend 

option applies a red color overlay 

to the base volume and green 

color overlay to the match volume.  

Color blending is useful when the 

two volumes are both grayscale or 

from the same modality. 

•	 Green-Red: The green-red blend 

option applies a green color 

overlay to the base volume and 

red color overlay to the match 

volume.
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Display Area (Continued)

Blend Type Options (continued): 

•	 Yellow-Cyan: The yellow-cyan 

blend option applies a yellow 

color overlay to the base volume 

and cyan color overlay to the 

match volume.   

 

•	 Cyan-Yellow: The cyan-yellow 

blend option applies a cyan color 

overlay to the base volume and 

yellow color overlay to the match 

volume. 

Manual Registration Tools: The 

manual registration tools [15] allow 

users to adjust the position of 

the match data set by translating 

or rotating the data in the axial, 

coronal, and sagittal orientations. 

When enabled users are also able to 

scale the match data manually in all 

orientations. 
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Display Area (Continued)

Manual Registration Tools (continued): 

•	 Rotate: The rotate buttons allow 

users to incrementally rotate 

the image data clockwise or 

counterclockwise relative to the 

selected orientation. Left click either 

rotate button to rotate the data in 

that direction. 

·· Rotate increment: The default 

number of pixels rotated at a 

time is 10, to adjust the number 

of degrees for each rotation left 

click on the yellow Rotate text and 

then choose Rotation Increment 

and then select for the options 

available [16].

·· Rotating with the mouse: Left 

click on the yellow Rotate text and 

a Rotate cursor will be displayed. 

While clicking and holding the 

left mouse button, move the 

mouse upward to rotate clockwise 

[17] and downward to rotate 

counterclockwise [18].
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Display Area (Continued)

Manual Registration Tools (continued): 

•	 Translate: The translate buttons allow users to incrementally translate 

the image data up or down or to the left or right, relative to the selected 

orientation. Left click any of the four translate buttons to translate the data in 

that direction.

·· Translate increment: The default number of pixels translated at a time is 1. 

To adjust the number of pixels for each translation left click on the yellow 

Translate text and then choose Translation Increment and then select for 

the options available [19].

·· Translating with the mouse: Left click on the image or click on the yellow 

Translate text and a Translate cursor will be displayed. Translation will mimic 

the movement of the mouse: while clicking and holding the left mouse 

button, move the mouse forward to translate the image up, backwards to 

translate the image down, right to move the translate the image right, and 

left to translate the image left [20]. Note, translation from the left mouse 

button is enabled by default, allowing translation of the match image data 

by clicking on it and moving the cursor. To disable this option right click in 

any of the Match display windows and uncheck the Left Drag to Translate 

option.

•	 Scale: The scale tools are not enabled by default; they can be enabled from 

the Other > Options menu. The scale buttons [21] allow users to incrementally 

translate the image data up or down or to the left or right, relative to the 

selected orientation. Left click any of the four translate buttons to translate the 

data in that direction.
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Display Area (Continued)

Manual Registration Tools > Scale 
(continued): 

·· Scale increment: To adjust the 

scale increment left click on 

the yellow Scale text and then 

choose Scale Increment (only 

available when scale is enabled) 

and then select for the options 

available [22].

·· Scaling data with the mouse: 
To scale using your mouse, left 

click on yellow Scale text and a 

Scale cursor will be displayed 

[23]. While clicking and holding 

the left mouse button, move 

the mouse forward to increase 

the vertical scale [24], move the 

mouse backwards to decrease 

the vertical scale [25]. 

 

Move the cursor to the right 

to increase the horizontal 

scale [26], left to decrease the 

horizontal scale [27].
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Display Area (Continued)

Manual Registration Tools Right Click Options: Right clicking on the manual 

registration tools provides access to the Rotation, Translation, and Scale Increment 

adjustment options. The right menu also provides access to an Interpolation option 

allowing users to select the following interpolation options for manual manipulation of 

the data; Nearest Neighbor, Linear, Bicubic (default), and Windowed Sync.

Display Area Right Mouse Options:  The following additional options are available 

from the right mouse menu in the Register display area. Note that the options available 

depend on the column selected (Base, Fused, Match). The options include:

·· Middle Button Action: Sets the action of the middle mouse button.

·· Rotate @ Point: Only available in the Register module, this option allows users to 

select a specific point to use to rotate the match input around. 

·· Mouse While Action: Sets the action of the middle mouse wheel.

·· Copy to Clipboard: Copies the current slice display to memory.

·· Isotropic: Active only for anisotropic data. Allows users to toggle between an 

isotropic or anisotropic display of the data.

·· Rotation Increment: Allows users to adjust the rotation increment (see Rotate Increment).

·· Translate Increment: Allows users to adjust the translation increment (see Translate Increment).

·· Scale Increment: Available when Scale is enabled. Allows users to adjust the scale increment (see Scale Increment).

·· Matrix: The matrix option allows users to: Load a matrix file (*.mat file) for the match data set; Save the current matrix file; or Reset: the 

matrix file, selecting from Axial, Coronal, or Sagittal. 

·· Alignment Grid: When selected a grid displays over the current image providing a reference aid for match data realignment [28].

·· Left Drag to Translate: Translation from the left mouse button is enabled by default, allowing users to translate the match image data 

by clicking on it and moving the cursor. To disable uncheck the option.

·· Reset: Resets all options to default. This option does not reset the matrix.
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Registration Controls

The Registration Controls are found in the left hand column of the Register Module Interface.

Register Type

Register Type indicates the current dimensionality mode; 2-D, 3-D, or 4-D. This is set automatically by Register 

and is dependent upon the data selected. Choosing two single 2D slices or a single 3D volume will open the 

Register in 2-D mode, selecting two 3D volumes will open Register in 3-D mode. Note, if multivolumes are 

selected, additional volume controls became available under 3-D mode. See Volumes for additional information. 

The Register algorithm is selectable and users can choose between Surface Alignment or Mutual Information.

Surface Alignment

Surface alignment, also referred to as surface matching, is a geometry-based registration method. Surface 

alignment is fast and robust, even in the presence of image noise and incomplete overlap of the input image 

volumes.

Surface alignment tries to maximize the overlap between 

corresponding surfaces extracted from two image inputs. 

To use surface alignment both input volumes must contain 

common objects which need be explicitly segmented from the 

grayscale image data, for example the brain from an MRI data 

set saved as either a grayscale or binary image prior to use in 

Register.

Alternatively, if the object is segmentable via thresholding 

(e.g. the brain from a SPECT image,) a surface can be defined 

interactively within Register using the threshold controls.



Analyze 14.0 User’s Guide	 © AnalyzeDirect, Inc.

496REGISTER > REGISTER MODULE INTERFACE

Registration Controls (continued)

A surface is extracted from both the base object 

(base image) and the match object (match image). 

The base object is used to create a chamfer distance 

volume. This is a volume in which each voxel has 

a value equal to the number of single-voxel steps 

from that coordinate to the nearest point on the 

base surface. Surface points are defined as any 

non-zero-valued voxel with at least one zero-valued 

orthogonal neighbor in 3-D space.

For the match object surface points are defined as 

any non-zero-valued pixel with at least one

zero-valued orthogonal neighbor within the same slice. To evaluate the error at any orientation, the coordinates of the selected ‘match 

surface’ points are transformed into the space of the base image, and the chamfer volume voxel values at those coordinates are summed. If 

all the match surface coordinates land on the base surface, the sum is zero. The minima search algorithm is a variant of simulated annealing 

which searches for minima at randomly determined multiple starting orientations, researching promising minima at successively higher 

resolution until a best minima is found.
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Mutual information registration is proven to be effective for 

registering image data from different modalities. Mutual information 

seeks to align voxels whose values have common probabilities of 

being present in their respective image sets. 

There are two components of the registration paradigm in Analyze:

1. The cost function used as the metric to judge when the volumes 

are in register.

2. The multiresolution search strategy used to find the global 

optimum of the cost function. 

The mutual Information cost function is based on the individual 

and joint entropy measured from the voxel values in the base and 

match volumes. There needs to be enough overlap and mutually 

shared signal from common structures for a relationship to be found 

between the two volumes and for them to be successfully co-

registered.

The mutual information algorithm determines the geometric 

transformation parameters used to spatially register the input data. 

The transformation parameters include both translation and rotation 

and scaling and shearing if enabled. The parameters are output in 

a homogeneous 4x4 matrix file. Image registration is achieved by 

transforming a volume using the transformation matrix.

Registration Controls (continued)
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2D registration determines the geometric transformation parameters to be used to align 2D images, slice-by-slice or matching a series of 

slices to a single base slice.

The following options are enabled/available with 2D registration:

2-D: The 2-D dimension mode is enabled when two 2D slices or a single 3D volume are loaded into Register.

Surface Alignment: Enables surface matching registration. The following options are available:

•	 Threshold: The Threshold double-ended slider bars for both the Base and Match data allows the end user to specify a range of 

threshold values to isolate common surfaces between the input images. Note, if common surfaces are not segmentable via thresholding 

the input data will need to be segmented prior to registration. 

·· Base: The base threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the base input data.

Registration Controls > 2D
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Registration Controls > 2D (continued)

2-D > Surface Alignment > Threshold (continued):

·· Match: The match threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the match input data.

•	 Show Thresholds: When enabled displays a filled preview of the minimum/maximum threshold value set for base and match input data.

Registration Matrix: When enabled displays the 4 by 4 transformation matrix. 

•	 Load: Load a matrix file (*.mat file) for the match data set.

•	 Save: Save the current matrix file.

Transformation Interpolation: The transformation interpolation option allows users to specify the interpolation type to be used when 

transforming the match data set. Users can choose from: 

•	 Nearest Neighbor: Allows users to select the nearest neighbor option for interpolation. Nearest Neighbor works by selecting the value 

of the closest voxel to which the interpolation resampling maps. This interpolation option is generally the fastest of the four available 

interpolation options.

•	 Linear: Allows users to select the linear option for interpolation. The linear algorithm applies a linear interpolation of grayscale intensity 

based on the distance of neighboring voxels from the interpolated voxel.

•	 Bicubic: Bicubic is the default interpolation option. The Bicubic option uses a cubic spline function to determine interpolated value, 

resulting in a smoother image that preserves detail. 

•	 Windowed Sinc: Allows users to select the Windowed Sinc option for interpolation. The algorithm uses the windowed sinc function 

sin(x)/x to determine the interpolated value.
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Slices: This option is only available when a single 3D volume is selected for input for 2D registration. The slices sliders allow users to 

navigate through the base and match inputs. 

•	 Base: The base slider controls the display of the base slice. This will also be the 2D slice used for registration. 

•	 Match: The match slider controls the display of the match slice. This will be the slice registered to the base for single Matrix and Single 

Reference registration. See Process and Registration mode for information on other registration options. 

Process: The process controls allow users to register and save registration result, the following options are available.  

•	 Save Registered: Allows users to save the transformed match image, the fused image, or the transformed object map (if applicable). 

See File > Save Registered at the being of this module section for a full description of the save options. 

•	 Register: Initiates the slice-to-slice registration. 

•	 Register Pairs: Only available when a single 3D volume is loaded. The register pairs option registered the current match slice to the 

current base slice. To adjust the select of the base or match slice input use the Slices sliders.

•	 Match Range: Only available when a single 3D volume is loaded. The match range slider allows users to specify a range of 2D match 

images to be registered to the base image.

Register Mode: Only available when a single 3D volume is loaded. The registration mode allows users to select from the following options: 

•	 Single Matrix: The single matrix option applies the transformation matrix created when registering the currently displayed match data 

set to the displayed base data to the range of match images selected using the match range slider. All images in the match range are 

transformed to the same single matrix.

Registration Controls > 2D (continued)
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Register Mode > Single Matrix (continued):

•	 Single Reference: The single reference option registers each of the match images specified in the match range, individually to the base 

image.

Registration Controls > 2D (continued)
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Register Mode (continued):

•	 Sequential: Performs a sequential match image to base image registration within the specified match range. For example, match image 

2 to base image 1, then match image 3 to based image 2, etc.

•	 Register Sequence: Only available for the single reference and sequential register modes. When selected initiates registration. 

Redo: Reverses your last undo action. Redo is only available after using Undo.

Undo: Reverses you last action. Can reverse more than one action. 

Registration Controls > 2D (continued)
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Mutual Information enables mutual information-based registration. The following options are available:

•	 Threshold: The Threshold double-ended slider bars for both the Base and Match data allows the end user to specify a range of 

threshold values to consider for registration. The use of thresholding with mutual information-based registration is normally to remove 

background noise, artifact from implants, or other ranges of greyscale values from the data that could interfere with registration. 

·· Base: The base threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the base input data.

·· Match: The match threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the match input data.

•	 Show Thresholds: When enabled displays a filled preview of the minimum or maximum threshold value set for base and match input 

data.

Match Sample Region: The match sample region slides allow users to increase or decrease the sampling density in the X, Y, and Z (if 

applicable).

•	 Minimum X Sample Extent: Use the slider to specify the x sampling density. Decreasing the x minimum value and increasing the x 

maximum value will increase the minimum x sample range [1]. Increasing the x minimum value and decreasing the x maximum value will 

decrease the minimum x sample range [2].

Registration Controls > 2D (continued)
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Match Sample Region (continued):

The minimum and maximum values can also be 

adjusted to select a specific x region or exclude a 

region that could interfere with registration [3].

•	 Y Sample Extent: As with the minimum X 

sample extent, users can use the minimum 

Y sample extent slider to specify the 

minimum y sampling density. Decreasing 

the y minimum value and increasing the y 

maximum value will increase the minimum y 

sample range [4]. Increasing the y minimum 

value and decreasing the y maximum value 

will decrease the minimum y sample range 

[5]. The minimum and maximum values can 

also be adjusted to select a specific y region 

or exclude a region that could interfere with 

registration.

•	 Z Sample Extent: Use the slider to specify 

the z sampling density.

•	 Show Region: Enables the display of the 

sample extent on the match image, showing 

the region as a purple and white dashed box.

Registration Controls > 2D (continued)
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DOF Search Ranges: The Degrees Of Freedom (DOF) search range allows users to adjust the default parameters set for registration.

•	 X Search: Allows users to adjust the maximum expected horizontal displacement (in either direction) of the match image in pixels.

•	 Y Search: Allows users to adjust the maximum expected vertical displacement (in either direction) of the match image in pixels.

•	 Z Rotation Search: Allows users to adjust the maximum expected rotation of the match image in degrees.

•	 Affine Register: Allows users to enable affine registration providing access to X and Y scale and shear search options:

·· X Scale Search: Adjust the maximum expected horizontal scaling difference between the match and base images

·· Y Scale Search: Adjust the maximum expected vertical scaling difference between the match and base images

·· X Shear in Y Search: Adjust the level of x shear in the y search.

·· Y Shear in X Search: Adjust the level of y shear in the x search.

•	 Bounded Search: Limits the total number of search steps.  The registration algorithm, while robust in most cases, can fail to converge 

in extremely low-information situations. This option avoids program hang-up in those situations, and seldom significantly affects typical 

solutions.

Registration Matrix: When enabled displays the 4 by 4 transformation matrix. 

·· Load: Load a matrix file (*.mat file) for the match data set.

·· Save: Save the current matrix file.

Transformation Interpolation: The transformation interpolation option allows users to specify the interpolation type to be used when 

transforming the match data set. Users can choose from: 

·· Nearest Neighbor: Allows users to select the nearest neighbor option for interpolation. Nearest Neighbor works by selecting the 

value of the closest voxel to which the interpolation resampling maps. This interpolation option is generally the fastest of the four 

available interpolation options.

Registration Controls > 2D (continued)
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Transformation Interpolation (continued):

·· Linear: Allows users to select the linear option for interpolation. The linear algorithm applies a linear interpolation of grayscale 

intensity based on the distance of neighboring voxels from the interpolated voxel.

·· Bicubic: Bicubic is the default interpolation option. The Bicubic option uses a cubic spline function to determine interpolated value, 

resulting in a smoother image that preserves detail. 

·· Windowed Sinc: Allows users to select the Windowed Sinc option for interpolation. The algorithm uses the windowed sinc function 

sin(x)/x to determine the interpolated value.

Slices: This option is only available when a single 3D volume is selected for input for 2D registration. The slices sliders allow users to 

navigate through the base and match inputs. 

·· Base: The base slider controls the display of the base slice. This will also be the 2D slice used for registration. 

·· Match: The match slider controls the display of the match slice. This will be the slice registered to the base for single Matrix and 

Single Reference registration. See Process and Registration mode for information on other registration options. 

Process: The process controls allow users to register and save registration result, the following options are available.  

·· Save Registered: Allows users to save the transformed match image, the fused image, or the transformed object map (if applicable). 

See File > Save Registered at the being of this module section for a full description of the save options. 

·· Register: Initiates the slice-to-slice registration. 

·· Register Pairs: Only available when a single 3D volume is loaded. The register pairs option registered the current match slice to the 

current base slice. To adjust the select of the base or match slice input use the Slices sliders.

·· Match Range: Only available when a single 3D volume is loaded. The match range slider allows users to specify a range of 2D match 

images to be registered to the base image.

Register Mode: Only available when a single 3D volume is loaded. The registration mode allows users to select from the following options: 

·· Single Matrix: Applies the transformation matrix created when registering the displayed match data set to the displayed base data to 

the images selected using the match range slider. All images in the match range are transformed to the same single matrix.

Registration Controls > 2D (continued)
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Register Mode (continued):

·· Single Reference: This option registers each of the match images specified in the match range, individually to the base image. 

·· Sequential: Performs a sequential match image to base image registration within the specified match range. For example, match 

image 2 to base image 1, then match image 3 to based image 2, etc. 

·· Register Sequence: Only available for the single reference and sequential register modes. When selected initiates registration.

Redo: Reverses your last undo action. Redo is only available after using Undo.

Undo: Reverses you last action. Can reverse more than one action.

Registration Controls > 3D
The 3-D dimension mode is enabled when two 3D volumes or one or more multivolumes (4D data sets) are loaded into Register.

Surface Alignment: Enables 3D surface matching registration. The following options are available:

•	 Threshold: The Threshold double-ended slider bars for both the Base and Match data allows the end user to specify a range of 

threshold values to isolate common surfaces between the input images. Note, if common surfaces are not segmentable via thresholding 

the input data will need to be segmented prior to registration. 

·· Base: The base threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the base input data.

·· Match: The match threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the match input data.

Show Thresholds: When enabled displays a filled preview of the minimum or maximum threshold value set for base and match input data.

Registration Controls > 2D (continued)
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Registration Matrix: When enabled displays the 4 by 4 transformation matrix. 

·· Load: Load a matrix file (*.mat file) for the match data set.

·· Save: Save the current matrix file.

Transformation Interpolation: The transformation interpolation option allows users to specify the interpolation type to be used when 

transforming the match data set. Users can choose from: 

·· Nearest Neighbor: Allows users to select the nearest neighbor option for interpolation. Nearest Neighbor works by selecting the 

value of the closest voxel to which the interpolation resampling maps. This interpolation option is generally the fastest of the four 

available interpolation options.

·· Linear: Allows users to select the linear option for interpolation. The linear algorithm applies a linear interpolation of grayscale 

intensity based on the distance of neighboring voxels from the interpolated voxel.

·· Bicubic: Bicubic is the default interpolation option. The Bicubic option uses a cubic spline function to determine interpolated value, 

resulting in a smoother image that preserves detail. 

·· Windowed Sinc: Allows users to select the Windowed Sinc option for interpolation. The algorithm uses the windowed sinc function 

sin(x)/x to determine the interpolated value.

Process: The process controls allow users to register and save registration result, the following options are available.  

·· Save Registered: Allows users to save the transformed match volume, fused volume, or the transformed object map (if applicable). 

See File > Save Registered at the being of this module section for a full description of the save options. 

·· Register: Initiates the 3D registration. 

·· Register Pair: Only available when the register mode is set to Single Reference or Sequential. Will initiate the registration of the 

current match volume to the current base volume. 

·· Match Range: Only available when one or more 4D multivolumes are loaded. The match range slider allows users to specify a range 

of 3D volumes in the 4D match multivolume to be registered to the base volume.

Registration Controls > 3D (continued)
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Register Mode: Only available when a single 4D volume is loaded. The registration mode allows users to select from the following options: 

·· Single Matrix: The single matrix option applies the transformation matrix created when registering the currently displayed match 

data set to the displayed base data to the range of match data sets selected using the match range slider. All volumes in the match 

range are transformed to the same single matrix.

·· Single Reference: The single reference option registers each of the match volumes specified in the match range, individually to the 

base volume.

·· Sequential: Performs a sequential match volume to base volume registration within the specified match range. For example, match 

volume 2 to base volume 1, then match volume 3 to based volume 2, etc. 

·· Register Sequence: Only available for the single reference and sequential register modes. When selected initiates sequential 

registration. 

Redo: Reverses your last undo action. Redo is only available after using Undo.

Undo: Reverses you last action. Can reverse more than one action. 

Volumes: This option is only available when one or more 4D multivolumes are selected for input for 3D registration. The Volume sliders 

allow users to navigate through the volumes in the match and/or base input multivolumes. 

·· Base: The base slider controls the display of the base volume. This will be the volume used for single matrix and single reference 

registration.

·· Match: The match slider controls the display of the match volume. This will be the volume registered to the base for Single Matrix and 

Single Reference registration. See Process and Registration mode for information on other registration options.

Mutual Information: Enables 3D mutual information-based registration. The following options are available:

•	 Threshold: The Threshold double-ended slider bars for both Base and Match data allows specifification of a range of threshold values 

to consider for registration. The use of thresholding with mutual information-based registration is normally to remove background noise, 

artifact from implants, or other ranges of greyscale values from the data that could interfere with registration.

Registration Controls > 3D (continued)
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Mutual Information > Threshold (continued): Enables 3D mutual information-based registration. The following options are available:

·· Base: The base threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the base input data.

·· Match: The match threshold double-ended slider bar allows users to specify a range of threshold values using the minimum and 

maximum ends of the threshold slide for the match input data.

•	 Show Thresholds: When enabled displays a filled preview of the minimum or maximum threshold value set for base and match input 

data.

Match Sample Region: The match sample region slides allow users to increase or decrease the sampling density in the X, Y, and Z.

·· X Sample Extent: Use the slider to specify the x sampling density. [1]

·· Y Sample Extent: Use the slider to specify the Y sampling density. [2]

·· Z Sample Extent: Use the slider to specify the Z sampling density. [3] 

·· Show Region: Enables the display of the sample extent on the match  

image. The region will be shown as a purple and white dashed box.

Registration Controls > 3D (continued)

DOF Search Ranges: The Degrees Of Freedom (DOF) search range allows users to adjust the 

default parameters set for registration.

·· X Search: Allows users to adjust the x translation search step.

·· Y Search: Allows users to adjust the y translation search step.

·· Z Search: Allows users to adjust the z translation search step.

·· X Rotation Search: Allows users to adjust the rotation about the x search step. 

·· Y Rotation Search: Allows users to adjust the rotation about the y search step. 

·· Z Rotation Search: Allows users to adjust the rotation about the z search step. 

·· Affine Register: Allows users to enable affine registration providing access to X, Y, and Z 

scale and shear search options:
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Registration Controls > 3D (continued)

DOF Search Ranges > Affine Register (continued):

·· X Scale Search: Allows users to adjust the X scaling search parameter.

·· Y Scale Search: Allows users to adjust the Y scaling search parameter.

·· Z Scale Search: Allows users to adjust the Z scaling search parameter.

·· X Shear in Z Search: Allows users to adjust the level of x shear in the z search.

·· Y Shear in Z Search: Allows users to adjust the level of y shear in the z search.

·· X Shear in Y Search: Allows users to adjust the level of x shear in the y search.

·· Z Shear in Y Search: Allows users to adjust the level of z shear in the y search.

·· Y Shear in X Search: Allows users to adjust the level of y shear in the x search.

·· Z Shear in X Search: Allows users to adjust the level of z shear in the x search.

•	 Bounded Search: Limits the total number of search steps.  The registration algorithm, while robust in most cases, can fail to converge 

in extremely low-information situations. This option avoids program hang-up in those situations, and seldom significantly affects typical 

solutions.

Registration Matrix: When enabled displays the 4 by 4 transformation matrix. 

·· Load: Load a matrix file (*.mat file) for the match data set.

·· Save: Save the current matrix file.

Transformation Interpolation: The transformation interpolation option allows users to specify the interpolation type to be used when 

transforming the match data set. Users can choose from: 

·· Nearest Neighbor: Allows users to select the nearest neighbor option for interpolation. Nearest Neighbor works by selecting the 

value of the closest voxel to which the interpolation resampling maps. This interpolation option is generally the fastest of the four 

available interpolation options.

·· Linear: Allows users to select the linear option for interpolation. The linear algorithm applies a linear interpolation of grayscale 

intensity based on the distance of neighboring voxels from the interpolated voxel.
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Registration Controls > 3D (continued)

Transformation Interpolation (continued):

·· Bicubic: Bicubic is the default interpolation option. The Bicubic option uses a cubic spline function to determine interpolated value, 

resulting in a smoother image that preserves detail. 

·· Windowed Sinc: Allows users to select the Windowed Sinc option for interpolation. The algorithm uses the windowed sinc function 

sin(x)/x to determine the interpolated value.

Process: The process controls allow users to register and save registration result, the following options are available.  

·· Save Registered: Allows users to save the transformed match volume, fused volume, or the transformed object map (if applicable). 

See File > Save Registered at the being of this module section for a full description of the save options. 

·· Register: Initiates the 3D registration. 

·· Register Pair: Only available when the register mode is set to Single Reference or Sequential. Will initiate the registration of the 

current match volume to the current base volume. 

·· Match Range: Only available when one or more 4D multivolumes are loaded. The match range slider allows users to specify a range 

of 3D volumes in the 4D match multivolume to be registered to the base volume. 

Register Mode: Only available when a single 4D volume is loaded. The registration mode allows users to select from the following options: 

·· Single Matrix: The single matrix option applies the transformation matrix created when registering the currently displayed match 

data set to the displayed base data to the range of match data sets selected using the match range slider. All volumes in the match 

range are transformed to the same single matrix.   

·· Single Reference: The single reference option registers each of the match volumes specified in the match range, individually to the 

base volume. 

·· Sequential: Performs a sequential match volume to base volume registration within the specified match range. For example, match 

volume 2 to base volume 1, then match volume 3 to based volume 2, etc. 

·· Register Sequence: Only available for the single reference and sequential register modes. When selected initiates sequential 

registration. 
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Registration Controls > 3D (continued)

Redo: Reverses your last undo action. Redo is only available after using Undo.

Undo: Reverses you last action. Can reverse more than one action. 

Volumes: This option is only available when one or more 4D multivolumes are selected for input for 3D registration. The Volume sliders 

allow users to navigate through the volumes in the match and/or base input multivolumes. 

•	 Base: The base slider controls the display of the base volume. This will be the volume used for single matrix and single reference 

registration.

•	 Match: The match slider controls the display of the match volume. This will be the volume registered to the base for Single Matrix and 

Single Reference registration. See Process and Registration mode for information on other registration options.
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Surface alignment is used to register image data that does not have enough or any mutual information, for example a functional SPECT 

scan and structural MRI scan. This exercise will provide the steps necessary to correctly register a SPECT scan and an MRI scan of the brain. 

However, first we will observe what happens when we try to register the image data set using Mutual Information.

To follow along, download data sets SISCOM_MRI.avw and SISCOM_Ictal_SPECT.avw from analyzedirect.com/data

•	 Open Input/Output and load both the SISCOM_MRI.avw and SISCOM_Ictal_SPECT.avw data sets into Analyze.

•	 Once loaded select the SISCOM_MRI data set then press and hold the Ctrl button on your keyboard and select the SISCOM_Ictal_

SPECT data set and open Register. Note the order in which the data is selected is important. The first data set selected will be loaded

3D Registration - Surface Alignment

·· as the base data set, in this 

example the MRI [1], while 

the second data set will be 

the match data set, in this 

example the SPECT [2].

•	 Set the Register Type to 

Mutual Information [3] and 

then click Register [4].
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Due to the lack of mutual information between 

these two modalities the registration will fail. Note 

the incorrectly positioned SPECT [5] with respect 

to the MRI.

In order to facilitate successful registration of 

the MRI and SPECT data we need to establish 

surfaces for common objects in both data sets, 

this means the explicit segmentation of the brain 

from the MRI and SPECT data sets.

•	 Close the Register module. 

•	 From the main Analyze window select 

the SISCOM_MRI data set and then open 

Segment. 

•	 From the Semi-Automatic tab [6] select 

Object Extractor [7].

•	 On Coronal slice 115 click in the white matter 

to set a seed point [8]. Adjust the threshold 

range [9] to define the brain, a minimum value 

of 21 and a maximum value of 47 works well 

for this data set.

•	 Click Extract Object [10].

3D Registration - Surface Alignment (continued)
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•	 After segmentation is complete 

notice that the brain object contains 

some minor holes. To correct for 

these holes, choose Fill Holes [11], set 

the Fill Type to 3-Pass [12],  click on 

the brain object [13] to initiate the fill 

process.

•	 Once the fill process is complete the 

brain will no longer contain any holes. 

Right-click on the brain object in 

the object list and then choose Save 

Grayscale from the menu [14].

3D Registration - Surface Alignment (continued)

•	 In the Save Grayscale window retuned change the name of the output file to SISCOM_MRI_Brain [15] and click Save Grayscale [16]. A 

grayscale version of the segmented brain object will be saved to the workspace, this will provide the surface of the brain for surface 

alignment with the SPECT data set.

•	 Close Segment. 

•	 As the brain surface in this SPECT data set can be easily isolated via thresholding in Register there is no need to segment the data 

set using Segment. However, if the SPECT image data contained extracranial signal that prevented a clear representation of the 

brain surface via thresholding the data set could be segmented to isolate the brain using Segment prior to use in Register.
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•	 Select the SISCOM_MRI_Brain data 

set then press and hold the Ctrl 

button on your keyboard now select 

the SISCOM_Ictal_SPECT data set 

and open Register.

•	 Set the Register Type to Surface 

Alignment [17].

•	 If desired modify the blend type 

[18].

•	 Next click the Show Threshold check 

box [19].

3D Registration - Surface Alignment (continued)

•	 Note that all voxels for both the base and match data sets are currently selected. To exclude the background voxels from the base 

volume set the Base minimum threshold level to 1 [20] by entering the value in the text field or by adjusting the slider. Note the 

update on the base display [21], only the voxels within the red mask will be considered for registration. 

•	 Adjust the threshold range for the match data set to remove the background voxels and all non-brain voxels. Set the minimum 

threshold value to 20 [22] by entering the value in the text field or by adjusting the slider. Note the update on the match display [23], 

the voxels within the red mask represent the brain and will provide the match surface to facilitate a successful registration.
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•	 Uncheck the Show Threshold option 

[24].

•	 To register the data click Register 

[25].

•	 After the registration is complete 

visually review the transformed and 

fused image data [26].

•	 Click Save Registered to save 

the Transformed SPECT data to 

the workspace and then close 

Register.

3D Registration - Surface Alignment (continued)
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The goal of this exercise is to demonstrate how to apply mutual information to registration of image data from two different modalities, 

MRI and PET. The MRI data set is sagittal acquisition anisotropic (non-cubic) data set, while the PET data set is an axial acquisition with 

isotropic voxels, so not only are the image data sets different modalities they also have different volume and voxel dimensions and were 

acquired in different orientations. To view this information right-click on the data once loaded into Analyze and then choose Info, review 

the volume metadata in the tab at the bottom of the Analyze window.  To follow along, download data sets MRI_Head and PET_ Head from 

analyzedirect.com/data. Open Input/Output and load both the MRI_Head and PET_ Head data sets into Analyze.

•	 Select the MRI_Head data set and while holding down the Ctrl key, select the PET_Head data set and then open Register.

•	 Select File > Input/Output Ports to view the input and output ports at the bottom of the Register window. Make sure that MRI_Head is 

the base volume, and PET_Head is the match volume. If the data was loaded incorrectly, click the Swap Inputs button to correct.

•	 The base MRI data set will display in the first column while the match PET data will display in the last column. 

3D Registration - Mutual Information

•	 At this point no registration has taken 

place, but the match data set has been 

correctly scaled to the base data set, 

displayed isotropically.

•	 The crosshair (linked cursor) [1] in each 

of the image display panes can be used 

to move through the volumes. When the 

crosshair is moved in any of the panes, the 

other panes automatically update. Note 

that the base and match coordinates are 

reported at the bottom of the window [2].

•	 Click the Register button [3].
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•	 After registration is complete, you will see that the PET volume has been scaled, rotated and translated to match the sagittal MRI [4].

•	 If desired right-click the Blend Type yellow text in the fused axial image (middle upper panel) [5] and change the blend type. 

•	 To evaluate the registration, move the crosshair in any of the panes. Note, if moving the crosshair in fused or match data you can 

unintentionally translate the data. If you do this click Undo to reverse the last action. To prevent this from happening again either right-

click in a fused or match image and uncheck the ‘Left Drag to Translate’ option or simply control the crosshair maneuvers from the base 

volume only. 

•	 If the registration is not satisfactory, you can choose to undo the last action using the Undo button at the bottom of the left tool bar. 

•	 If you want to reset the data back to the original matrix, use the Reset button in the top right of the register window [6].

3D Registration - Mutual Information (continued)

•	 To view the current transformation matrix, 

select the Registration Matrix box [7] on 

the left tool bar. This gives the option 

to save the current matrix as an ASCII 

floating-point file or load a previously 

saved matrix.

•	 To save a copy of the transformed PET 

data set or fused MRI/PET data set, 

click Save Registered [8]. Select the 

Transformed Save Type, Workspace, File 

and then select Save Transformed.

•	 When finished close Register.
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Sometime image registration will fail, fortunately the Register module provides several tools to help optimize conditions to achieve 

registration. Common problems include:

·· •	 Not enough overlapping information between input data sets

·· •	 Background or artifact noise

·· •	 Adjusting the sample region to include/exclude regions in the match data

Not enough overlapping information between input data sets

•	 Download data sets Register_MRI_Base.avw and Register_MRI_Match.avw from analyzedirect.com/data to follow along.

•	 Use Input/Output to load the two data sets into Analyze. Select the Register_MRI_Base data set and while holding down the Ctrl key, 

select the Register_MRI_Match data set and then open Register.

Troubleshooting Registration Problems

•	 Select File > Input/Output Ports to view 

the input and output ports at the bottom 

of the Register window. Confirm that the 

Register_MRI_Base data set is assigned 

as the ‘Base Volume’ and Register_MRI_

Match data set is assigned as the ‘Match 

Volume’. If the data is loaded incorrectly 

use the Swap Inputs option to correct.

•	 Use the Blend Type [1] to set a Red-Green 

blend for the fused image. The blend 

will help with visual assessment of the 

registration result as both the base and 

match data sets are grayscale.

•	 Press the Register button [2].
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•	 Examine the Fused image data in the 

center column [3]. It is clear to see that the 

registration process failed. These image 

inputs do not have enough overlapping 

mutual information to facilitate a successful 

registration, however, the resolution to 

this issue is quite simple, the match data 

set needs to be manually adjusted so it 

has a new starting point closer to the base 

image.

•	 Since the registration is not acceptable 

click the Reset Matrix button [4].

Not enough overlapping information between input data sets

•	 Left click on the coronal fused or match image and drag the data down slightly [5]. Release the mouse when the ventricles are aligned 

closer [6].

•	 Alternatively, use the down translation arrow [7] to move the coronal match  

image down 5 voxels.
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•	 Press the Register button. 

•	 This time the image data will register 

correctly. Notice that the fused image 

will appear yellow [8] when aligned 

correctly. Use the Save Register [9] to 

save the transformed image data to 

the workspace. 

•	 Note that when troubleshooting data 

you are experiencing problems with 

may need to make larger adjustments 

that could also include rotations and 

manipulations in all three orientations.

•	 Close Register.

Not enough overlapping information between input data sets (continued)
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Noise in the background of the image 

or from artifact in the image can prevent 

successful registration of image data. 

In this example, registration of a post-

operative CT to a pre-operative MRI fails 

due to the artifact from the electrodes in 

the CT data set [1].

However, simply setting a threshold 

range to exclude the voxels in the match 

data set that represent the electrodes, 

by decreasing the maximum threshold 

value [2], and the streak artifact from the 

electrodes, by increasing the minimum 

threshold value [3], allows for a successful 

registration [4].

Background or artifact noise
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Registration can fail if not enough of 

the match data is considered for the 

registration. Registration can also fail 

if the match region considered for 

registration contains a region of large 

morphological change from the base 

data set, such as an implant in a post-

implant data set. The match sample 

region allows users to adjust to match 

region considered for the registration, 

increasing or decreasing the match region 

as necessary. 

The match sample region provides 

X, Y and Z sample extent sliders that 

define a specific spatial region used for 

registration. A dotted boundary line will 

appear on the right match image column 

[1] when the option is enabled.

In this example registration between 

a pre-procedure and post-procedure 

Cone Beam CT (CBCT) scans fails as the 

CBCT scans were acquired from different 

scanners with different parameters [2].

Adjusting the sample region to include or exclude regions in the match data
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Adjustment of the match sample 

region to increase the X sample 

range [3] remedied the problem and 

allowed for successful registration of 

the image data [4].

Adjusting the sample region to include or exclude regions in the match data (continued)


